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Introduction

Important: This is a preliminary document for an API or technology in development. Although this
document has been reviewed for technical accuracy, it is not final. Apple is supplying this information
to help you plan for the adoption of the technologies and programming interfaces described herein.
This information is subject to change, and software implemented according to this document should
be tested with final operating system software and final documentation. Newer versions of this
document may be provided with future seeds of the API or technology. For information about updates
to this and other developer documentation, view the New & Updated sidebars in subsequent
documentation seeds.
This tutorial shows how to create a simple iPhone application. It is not intended to give complete
coverage of all the features available, but rather to introduce some of the technologies and give you
a grounding in the fundamentals of the development process.
You should read this document if you are just starting development with iPhone using Cocoa Touch.
You should already have some familiarity with the Objective-C programming language. If you don’t,
read through at least the first few chapters of the The Objective-C 2.0 Programming Language—up to
and including the chapter about declared properties.
The goal here is not to create a finely polished application, but to illustrate:
■

How you create and manage a project using Xcode

■

The fundamental design patterns and techniques that underlie all iPhone development

■

The basics of using Interface Builder

■

How to make your application respond to user input using standard user interface controls

A secondary goal is to point out other documents that you must also read to fully understand the
iPhone development tools and techniques.
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Introduction

Note: As a convention, >> denotes the beginning of a paragraph (sometimes including the following
bulleted list) that contains steps that you must perform in the tutorial.
In code listings, comments included in Xcode template files are not shown.

Organization of This Document
The document is split into the following chapters:
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■

“Tutorial Overview and Design Patterns” (page 9)

■

“Creating Your Project” (page 13)

■

“Adding a View Controller” (page 19)

■

“Adding a Nib File” (page 27)

■

“Configuring the View” (page 33)

■

“Implementing the View Controller” (page 41)

■

“What Next?” (page 47)

Organization of This Document
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Tutorial Overview and Design Patterns

This chapter provides an overview of the application you’re going to create and the design patterns
you’ll use.

Tutorial Overview
In this tutorial, you’re going to create a very simple application. It has a text field, a label, and a button.
You can type your name into the text field then press the button and the label’s text will be updated
to show “Hello, <Name>!”:

Tutorial Overview
2008-05-27 | © 2008 Apple Inc. All Rights Reserved.
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Even though this is a very simple application, it introduces the fundamental design patterns, tools,
and techniques that underlie all iPhone development using Cocoa Touch. Cocoa Touch comprises
the UIKit and Foundation frameworks which provide the basic tools and infrastructure you need to
implement graphical, event-driven applications in iPhone OS. It also includes several other frameworks
that provide key services for accessing device features, such as the user’s contacts. To learn more
about Cocoa Touch and where it fits into the iPhone OS, read iPhone OS Programming Guide. The main
patterns you’re going to use are described in “Design Patterns” (page 10).
In this tutorial, little regard is given to the user interface. Presentation is, however, a critical component
of a successful iPhone application. You should read the iPhone Human Interface Guidelines and explore
the sample code based on this tutorial (HelloWorldClassic) to understand how the user interface
might be improved for a full-fledged application.
You’ll also start to gain an understanding of how view controllers work and how they fit into the
architecture of an iPhone application.

Design Patterns
If you haven’t already, you should make sure you read the design patterns chapter in Cocoa
Fundamentals Guide, however the main patterns you’re going to use are:
■

Delegation

■

Model View Controller

■

Target-Action

Here’s a quick summary of these patterns and an indication of where they’ll be used in the application.

Delegation
Delegation is a pattern where one object periodically sends messages to another object specified as
its delegate to ask for input or to notify the delegate that an event is occurring. You use it as an
alternative to class inheritance for extending the functionality of reusable objects.
In this application, the application object tells its delegate that the main start-up routines have finished
and that the custom configuration can begin. For this application, you want the delegate to create an
instance of a controller to set up and manage the view. In addition, the text field will tell its delegate
(which in this case will be the same controller) when the user has tapped Return.
Delegate methods are typically grouped together into a protocol. A protocol is basically just a list of
methods. If a class conforms to a protocol, it guarantees that it implements the required (some may
be optional) methods of a protocol. The delegate protocol specifies all the messages an object might
send to its delegate. To learn more about protocols and the role they play in Objective-C, see the
Protocols chapter in The Objective-C 2.0 Programming Language.

Model-View-Controller
The Model-View-Controller (or “MVC”) design pattern sets out three roles for objects in an application.
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Model objects represent data such as SpaceShips and Rockets in a game, ToDo items and Contacts
in a productivity application, or Circles and Squares in a drawing application.
In this application, the data is going to be very simple—just a string—and it’s not actually used outside
of a single method, so strictly speaking it’s not even necessary. It’s the principle that’s important here,
though. In other applications the model will be more complicated and accessed from a variety of
locations.
View objects know how to display data and may allow the user to edit the data.
In this application you need a main view to contain several other views—a text field to capture
information from the user, a second text field to display text based on the user’s input, and a button
to let the user tell us that the secondary text should be updated.
Controller objects mediate between models and views.
In this application, the controller object will take the data from the input text field, store it in a string,
and update a second text field appropriately. The update will be initiated as a result of an action sent
by the button.

Target-Action
The target-action mechanism enables a control object—that is, an object such as a button or slider—to
send a message to another object that can interpret the message and handle it as an application-specific
instruction.
In this application, when it’s tapped, a button tells the controller to update its model and view based
on the user’s input.

Design Patterns
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In this first chapter, you create the project using Xcode and find out how an application launches.

Xcode
The main tool you use to create applications for iPhone is Xcode—Apple’s IDE (integrated development
environment). You can also use it to create a variety of other project types, including Cocoa and
command-line utilities.
>> Launch Xcode (by default it’s in /Developer/Applications), then create a new project by choosing
File > New Project. You should see a new window like this:

Xcode
2008-05-27 | © 2008 Apple Inc. All Rights Reserved.
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>> Select the Cocoa Touch Window-Based Application icon (the gray icon with the crossed screwdriver
and wrench—not shown in the previous picture) and click Choose. A sheet appears to allow you to
select where your project will be saved. Select a suitable location (such as the Desktop or a custom
Projects directory), then give the project a name such as HelloWorld and click Save.
Note: The remainder of the tutorial assumes that you named the project HelloWorld, so the application
delegate class is called HelloWorldAppDelegate. If you name your project something else, then the
application delegate class will be called YourProjectNameAppDelegate.
You should see a new project window like this:

If you haven’t used Xcode before, take a moment to explore the application. You should read Xcode
Workspace Guide to understand the organization of the project window and how to perform basic
tasks like editing and saving files.
>> You can now build and run the application by choosing Build > Build and Go (Run) or by clicking
the Build and Go button in the toolbar. The iPhone Simulator application should launch automatically,
and when your application starts up you should simply see a white screen. Quit the Simulator.
To understand where the white screen came from, you need to understand how the application starts
up.

14
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Application Bootstrapping
The template project you created already sets up the basic application environment. It creates an
application object, connects to the window server, establishes the run loop, and so on. Most of the
work is done by the UIApplicationMain function as illustrated in Figure 2-1.
Figure 2-1

Application bootstrapping

<UIApplicationMain>

UIApplication

Looks at

info.plist
<MainNibFile> = “Main Window”

The main function in main.m calls the UIApplicationMain function:
int retVal = UIApplicationMain(argc, argv, nil, nil);

This creates an instance of UIApplication. It also scans the application’s Info.plist file. The
Info.plist file is a dictionary that contains information about the application such as its name and
icon. It may contain the name of the nib file the application object should load, specified by the
NSMainNibFile key. Nib files contain an archive of user interface elements and other object—you’ll
learn more about them later in the tutorial. In your project’s Info.plist file you should see:
<key>NSMainNibFile</key>
<string>MainWindow</string>

This means that when the application launches, the MainWindow nib file is loaded.
>> To look at the nib file, double-click MainWindow.xib in the Resources group in the project window
(the file has the extension “xib” but by convention it is referred to as a “nib file”). Interface Builder
launches and opens the file.

Application Bootstrapping
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The Interface Builder document contains four items:
■

A File’s Owner proxy object. The File’s Owner object is actually the UIApplication
instance—File’s Owner will be discussed later, in “Configuring File’s Owner” (page 29).

■

A First Responder proxy object. The First Responder is not relevant to this tutorial but you can
learn more about it by reading Event Handling in iPhone OS Programming Guide.

■

An instance of HelloWorldAppDelegate set to be the application's delegate. Delegates will be
discussed in the next section.

■

A window. The window has its background set to white and is set to be visible at launch. It’s this
window that you see when the application launches.

After the application has finished launching, you can perform additional customization as illustrated
in this diagram:

16
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applicationDidFinishLaunching:
1

Create UIViewController

2

Get UIViewController’s view

3

Put view in window

UIApplication

MyViewController 1
view
LoadView
(Loads nib file)

Delegate

2
3

When the application object has completed its setup, it sends its delegate an
applicationDidFinishLaunching: message. Your application’s delegate class already includes a
stub implementation of this method. To customize the application, in this method you need to obtain
a view and set that as the main view for the window. Typically in an iPhone application you pass
responsibility for managing a view to a view controller (a special controller responsible for managing
a view). (This adheres to the model-view-controller design pattern as described in
“Model-View-Controller” (page 10).) You’ll see how to do this in the next chapter.

Recap
In this chapter you created a new project and learned about how the application launch process works.
In the next chapter, you’ll define and create an instance of a view controller.

Recap
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In this application you’ll need two classes. Xcode’s application template provided an application
delegate class and an instance is created in the nib file. You need to implement a view controller class
and create an instance of it.

Adding a View Controller Class
View controller objects play a central role in most iPhone applications. As the name implies, they’re
responsible for managing a view, but on iPhone they also help with navigation and memory
management. You’re not going to use the latter features here, but it’s important to be aware of them
for future development. UIKit provides a special class—UIViewController—that encapsulates most
of the default behavior you want from a view controller. You have to create a subclass to customize
the behavior for your application.
>> In Xcode, in the project organizer select either the project (HelloWorld at the top of the Groups
and Files list) or the Classes group folder—the new files will be added to the current selection.
>> Choose File > New File and in the New File window. Select the Cocoa Touch Classes group, then
select UIViewController subclass.

Adding a View Controller Class
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>> Click Next, and in the following screen give the file a new name such as MyViewController (by
convention, class names begin with a capital letter). Make sure that both the .m and .h files are created
and that the files are added to your project, as shown here:
Figure 3-1

MyViewController

>> Click Finish and make sure that the files were added to your project.

20
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If you look at the new files, you’ll see that stub implementations of various methods are already given
to you. These are all you need for the moment; the next task is to create an instance of the class.

Adding a View Controller Object
You want to make sure that the view controller lasts for the lifetime of the application, so it makes
sense to add it as an instance variable of the application delegate (which will also last for the lifetime
of the application). (To understand why, consult Memory Management Programming Guide for Cocoa.)
>> In the header file for the application delegate class (HelloWorldAppDelegate.h), add an instance
variable by adding the following line between the braces:
MyViewController *myViewController;

Also add a declaration for this property after the closing brace but before @end:
@property (nonatomic, retain) MyViewController *myViewController;

Properties are described in the Properties chapter in The Objective-C 2.0 Programming Language. Basically,
though, this declaration specifies that an instance of HelloWorldAppDelegate has a property that
you can access using the getter and setter methods myViewController and setMyViewController:
respectively, and that the instance retains the property (retaining is discussed in more detail later).
>> Add this declaration before the interface declaration for HelloWorldAppDelegate.
@class MyViewController;

The compiler will generate an error if you don’t tell it about the MyViewController class. You could
import the header file, but typically in Cocoa you provide a forward declaration like this one, which
is a promise to the compiler that MyViewController will be defined somewhere else and that it
needn’t waste time checking for it now. (Moreover, it avoids circularities if two classes need to refer
to each other and would otherwise include each other’s header files.)

Interface Source Listing
To make sure you’re on track, confirm that your HelloWorldAppDelegate class interface file looks
like this (comments are not shown):
#import <UIKit/UIKit.h>
@class MyViewController;
@interface HelloWorldAppDelegate : NSObject {
IBOutlet UIWindow *window;
MyViewController *myViewController;
}
@property (nonatomic, retain) UIWindow *window;
@property (nonatomic, retain) MyViewController *myViewController;

Adding a View Controller Object
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@end

You can now create an instance of the view controller.

Creating the View Controller Instance
>> In the implementation file for the application delegate class (HelloWorldAppDelegate.m), create
an instance of MyViewController by adding the following code as the first statements in the
implementation of the applicationDidFinishLaunching: method:
MyViewController *aViewController = [[MyViewController alloc]
initWithNibName:@"ControllerView" bundle:[NSBundle mainBundle]];
self.myViewController = aViewController;
[aViewController release];

There’s quite a lot in just these three lines. What they do is:
■

Create and initialize an instance of the view controller class.

■

Set the new view controller to be the myViewController instance variable using an accessor
method.

■

Adhere to memory management rules by releasing the view controller.

You create the view controller object using alloc, then initialize it using initWithNibName:bundle:.
The init method specifies first the name of the nib file the controller should load and second the
bundle in which it should find it. You haven’t created the nib file yet—you’ll do that in the next
chapter. A bundle is an abstraction of a location in the file system that groups code and resources that
can be used in an application. The advantages of using bundles over locating resources yourself in
the file-system are that bundles provide a convenient and simple API—the bundle object can locate
a resource just by name—and they take account of localization for you. To learn more about bundles,
see Resource Programming Guide.
By convention, you own any objects you create using an alloc method (amongst others, see Memory
Management Rules). By convention you should also:
■

Relinquish ownership of any objects you create.

■

Typically use accessor methods to set instance variables anywhere other than in an initializer
method.

The second line in the implementation uses an accessor method (the dot syntax invokes the appropriate
accessor method) to set the instance variable, and then the third line uses release to relinquish
ownership.
There are other ways to implement the above. You could, for example, replace the three lines with
just two:
MyViewController *aViewController = [[[MyViewController alloc]
initWithNibName:@"ControllerView" bundle:[NSBundle mainBundle]]
autorelease];
self.myViewController = aViewController;

22

Creating the View Controller Instance
2008-05-27 | © 2008 Apple Inc. All Rights Reserved.

C H A P T E R

3

Adding a View Controller

In this version, you use autorelease as a way to relinquish ownership of the new view controller
but at some point in the future. To understand this, read Autorelease Pools in the Memory Management
Programming Guide for Cocoa. In general, however, you should try to avoid using autorelease wherever
possible as it’s a more resource intensive operation than release.
Invoking the setMyViewController: method calls exactly the same code as using the dot notation
in the original implementation. The dot notation simply provides a more compact syntax—especially
when you use nested expressions. Which syntax you choose is largely personal preference, although
using the dot syntax does have some additional benefits when used in conjunction with properties—see
Properties in The Objective-C 2.0 Programming Language.

Setting Up the View
The view controller is responsible for managing and configuring the view when asked. Rather than
creating the window’s content view directly, therefore, you ask the view controller for its view and
add that as the subview for the window.
>> After releasing the view controller, add the following lines:
UIView *controllersView = [myViewController view];
[window addSubview:controllersView];

You could do this in one line:
[window addSubview:[myViewController view]];

But breaking it into two serves to highlight the side of memory management that is the converse of
that which you saw earlier. Because you didn’t create the controller view using any of the methods
listed in Memory Management Rules in Memory Management Programming Guide for Cocoa, you don’t
own the returned object. Consequently you can simply pass it to the window and forget about it (you
don’t have to release it).

Housekeeping
There are a few unfinished tasks to complete: You need to import the view controller’s header file,
synthesize the accessor methods, and—to conform to the rules of memory management—make sure
the view controller is released in the dealloc method.
>> In the implementation file for the application delegate class (HelloWorldAppDelegate.m), do the
following:
■

At the top of the file, import the header file for MyViewController:
#import "MyViewController.h"

■

In the @implementation block of the class, tell the compiler to synthesize the accessor methods
for the view controller:
@synthesize myViewController;

Setting Up the View
2008-05-27 | © 2008 Apple Inc. All Rights Reserved.

23

C H A P T E R

3

Adding a View Controller

■

In the dealloc method, release the view controller in the first statement:
[myViewController release];

As a test, you can compile your project by clicking Build in the project window’s toolbar. It should
compile without error.
You can’t run the application in iPhone Simulator at the moment because the view controller will try
to load its view from the ControllerView nib file and fail (the application will crash) because you
haven’t provided it yet. If you do want to check that the application runs, you can set the nib file
name to nil:
MyViewController *aViewController = [[[MyViewController alloc]
initWithNibName:nil bundle:[NSBundle mainBundle]] autorelease];

in which case, when the application runs, the view controller will create a default view and display
a white screen as before. If you do make this change, remember to revert back to the original afterwards.

Implementation Source Listing
To make sure you’re on track, confirm that your HelloWorldAppDelegate class implementation looks
like this:
#import "MyViewController.h"
#import "HelloWorldAppDelegate.h"
@implementation HelloWorldAppDelegate
@synthesize window;
@synthesize myViewController;

- (void)applicationDidFinishLaunching:(UIApplication *)application {
MyViewController *aViewController = [[MyViewController alloc]
initWithNibName:@"ControllerView" bundle:[NSBundle mainBundle]];
self.myViewController = aViewController;
[aViewController release];
UIView *controllersView = [myViewController view];
[window addSubview:controllersView];
}

- (void)dealloc {
[myViewController release];
[window release];
[super dealloc];
}
@end

24
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Recap
In this section you added a new view controller class. In the application delegate, you declared an
instance variable and accessor methods for a view controller instance. You also synthesized the
accessor methods and performed a few other housekeeping tasks. Most importantly, though, you
created an instance of the view controller and passed its view to the window. In the next chapter
you’ll use Interface Builder to create the nib file the controller uses to load its view.

Recap
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You use the Interface Builder application to create a nib file. There are two important concepts to
introduce: outlets, and the File’s Owner proxy object.

Interface Builder
Interface Builder is the application you use to create user interfaces. It doesn’t generate source code,
instead it allows you to manipulate objects directly and then save those objects in an archive called
a nib file. At runtime, when a nib file is loaded the objects are unarchived and restored to the state
they were in when you saved the file—including all the connections between them. To learn more
about Interface Builder, read Interface Builder User Guide.

Create the Nib File
>> Launch Interface Builder (by default it’s in /Developer/Applications).
>> In the templates selection window select Cocoa Touch in the list on the left and then select the
View template. If Interface Builder is already running and the template selection window is not visible,
choose File > New.

Interface Builder
2008-05-27 | © 2008 Apple Inc. All Rights Reserved.
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The new file contains three objects, the File’s Owner proxy, the First Responder proxy, and a view.
The view is displayed in a separate window to allow you to edit it.

28
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>> Before editing the view, save the file into your project directory—call it ControllerView (the
name must match the name you specified in initWithNibName:bundle:—see “Creating the View
Controller Instance” (page 22)).
>> After you save the file, Interface Builder asks if you want to add it to the project. You do. (Note:
Xcode must be running for you to see this dialog. If Xcode is not running, you won’t see the dialog.
When you open the project again, you can instead drag the nib file from Finder into the Resources
group in your project yourself.)

Make sure that the file does appear in the project files listing. By convention, you should move it to
the Resources group.

Configuring File’s Owner
In an Interface Builder document, in contrast to the other objects you add to the interface, the File’s
Owner object is not created when the nib file is loaded. It represents the object set to be the owner of
the user interface—typically the object that loads the interface. This is discussed in more detail in
Resource Programming Guide. In your application, the File’s Owner will be the instance of
MyViewController, but you have to specify this in the file.
>> In the Interface Builder document window, select the File’s Owner icon and then choose Tools >
Identity Inspector to display the Identity inspector as shown here:

Configuring File’s Owner
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>> In the Class field of the Class Identity section, enter MyViewController. If you start typing the
class name, Interface Builder auto-completes it; alternatively you can choose the class name from the
pop-up menu. It’s important not to misspell the name; if you do, Interface Builder won’t let you make
the appropriate connections.
This is a promise to Interface Builder that the File’s Owner will be an instance of MyViewController.
You can now make appropriate connections from the File’s Owner to other objects in the nib file.

Connecting the View Outlet
The only connection to make at the moment is the view controller’s view outlet. An outlet is just an
instance variable of an object that happens to connect to an item in a nib file. One way to set an outlet
is to Control-drag from the object whose outlet you want to set to the destination object.
>> In the Interface Builder document window, Control-drag from File’s Owner to the View:

30
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When you release the mouse button, Interface Builder displays a transparent panel showing the
available outlets for the source object:

>> Select view. When the nib file is loaded, the instance UIView is unarchived; then the view controller’s
view instance variable is set to that view.
>> Save the file.
>> You can now compile and run the application (click the Build and Go button in the toolbar). Your
application should compile without errors and you should again see a white screen in Simulator.
To make sure your application’s working correctly, you could set the background color of the view
to something other than white and verify that the new color is displayed after the application launches.
In Interface Builder, select the view then choose Tools > Attributes Inspector to display the Attributes
inspector. Click the frame of the Background color well to display the Colors panel, then select a
different color. Save the nib file before compiling and running again.

Connecting the View Outlet
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Loading the Nib File
The view controller loads the nib file automatically in its loadView method. The loadView method
is typically called once during a view controller’s lifetime and is used to create its view. When you
invoke the view controller’s view method, the controller automatically calls its own loadView method
if the view hasn’t been created. (If the view controller purges its view as a result of, for example,
receiving a memory warning, then loadView will be invoked again to recreate the view if necessary.)
If you want to create the view controller’s view programmatically, you can override loadView and
create the view in your implementation.
If you initialize a view controller using initWithNibName:bundle: but you want to perform additional
configuration after the view is loaded, you override the controller’s viewDidLoad method.
You can load nib files yourself using an instance of NSBundle. You can learn more about loading nib
files in Resource Programming Guide.

Recap
In this section you created a new nib file and added it to the project. You configured the File’s Owner
proxy object to represent the view controller and connected its view outlet to the view. You also
learned more about resource loading and how the view controller loads the nib file.
In the next chapter you will add controls to the view.
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Interface Builder provides a library of objects that you can add to a nib file. Some of these are user
interface elements such as buttons and text fields, others are controller objects such as view controllers.
Your nib file already contains a view—now you just need to add the button and text fields.

Adding the User Interface Elements
>> In Interface Builder choose Tools > Library to display the library window:

Adding the User Interface Elements
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You can drag view items from the library and drop them onto the view just as you might in a drawing
application. You can then resize the items using resize handles where appropriate, and reposition
them by dragging. As you move items within the view, alignment guides are displayed as dashed
blue lines.
>> Add a text field (UITextField), a label (UILabel), and a button (UIButton) to the view and lay
them out so that they look like this:
Figure 5-1

View containing user interface elements and showing a guide line

>> Make the following visual changes:
1.

Add a placeholder string Your Name to the text field by entering it in the Text Field Attributes
inspector.

2.

Resize the label so that it extends for the width of the view.

3.

Add a title to the button by double-clicking inside the button and typing Hello.

4.

Use the inspector to set the text alignment for the text field and label to centered.

5.

Save the file.

You should end up with a view that looks like this:
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>> In the view section of the label’s Label Attributes inspector, select Clear Context Before Drawing.
This ensures that when you update the greeting the previous string is removed before the new one
is drawn. If you don’t do this, the strings are drawn on top of each other.
There are several other changes to make to the text field—it might be fairly obvious that the first
change applies to the text field, but the others are less obvious. First, you might want to ensure that
names are automatically capitalized. Second, you might want to make sure that the keyboard associated
with the text field is configured for entering names, and that the keyboard displays a Done button.
The guiding principle here is that: you know when you’re putting it on screen what a text field will
contain. You therefore design the text field to make sure that at runtime the the keyboard can configure
itself to best suit the user’s task. You make all of these settings using text input traits.
>> In Interface Builder, select the text field then display the Attributes inspector. In the Text Input
Traits section:
■

In the Capitalize popup menu, select Words.

■

In the Keyboard Type popup menu select, Name Phone Pad.

■

In the Keyboard Return Key popup menu, select Done.

If you build and run your application in Xcode, when it launches you should see the user interface
elements as you positioned them. If you press the button, it should highlight, and if you tap inside
the text field, the keyboard should appear. At the moment, though, after the keyboard appears, there’s
no way to dismiss it. To remedy this, and add other functionality, you need to make appropriate
connections to and from the view controller.

Adding the User Interface Elements
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The View Controller Interface Declaration
To make connections to the user interface from the view controller, you need to specify outlets (an
outlet is just an instance variable). You also need a declaration for its very simple model object, the
string.
>> In Xcode, in MyViewController.h add the following instance variables to the MyViewController
class:
IBOutlet UITextField *textField;
IBOutlet UILabel *label;
NSString *string;

IBOutlet is a special keyword that is used only to tell Interface Builder to treat the instance variable

as an outlet. It’s actually defined as nothing so it has no effect at compile time.
>> You then need to add property declarations for the instance variables and a declaration for the
changeGreeting: action method:
@property (nonatomic, retain) UITextField *textField;
@property (nonatomic, retain) UILabel *label;
@property (nonatomic, copy) NSString *string;
- (IBAction)changeGreeting:(id)sender;

IBAction is a special keyword that is used only to tell Interface Builder to treat a method as an action
for target/action connections. It’s defined to void.

The view controller is also going to be the text field’s delegate; as such, it must adopt the
UITextFieldDelegate protocol (see “Delegation” (page 10)). To specify that a class adopts a protocol,
in the interface add the name of the protocol in angle brackets (<>) after the name of the class from
which your class inherits.
>> Specify that the UIViewController object adopts the UITextFieldDelegate protocol by adding
<UITextFieldDelegate> after UIViewController.
Your interface file should look like this:
#import <UIKit/UIKit.h>
@interface MyViewController : UIViewController <UITextFieldDelegate> {
IBOutlet UITextField *textField;
IBOutlet UILabel *label;
NSString *string;
}
@property (nonatomic, retain) UITextField *textField;
@property (nonatomic, retain) UILabel *label;
@property (nonatomic, copy) NSString *string;
- (IBAction)changeGreeting:(id)sender;
@end

>> Save the MyViewController.h file so that Interface Builder will notice the changes.
>> So that you can test the project, in the implementation file (MyViewController.m) implement a
stub changeGreeting: method. After the @implementation MyViewController line add:
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- (IBAction)changeGreeting:(id)sender {
}

>> Save the file.
If you inspect the File’s Owner object in Interface Builder you should now see that the outlets and
action are displayed:

>> You now need to establish the connections:
■

For the outlets, you can Control-drag from File’s Owner object to the label and text field just as
you did for the view outlet. You can also Control click File’s Owner to display a transparent panel
that shows all the available outlets and actions. You then drag from the circle to the right of the
list to the destination to make the connection.

The View Controller Interface Declaration
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■

38

For the button’s action method, Control-click the button to show the inspector. Then drag from
Touch Up Inside to File’s Owner and select changeGreeting: in the transparent panel that
appears over File’s Owner (you may have to scroll within the inspector to reveal the Touch Up
Inside connection). Now when you touch and release the button, it sends a changeGreeting:
message to the File’s Owner object.

The View Controller Interface Declaration
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■

Set the text field’s delegate to be the File’s Owner (the view controller) by Control-dragging from
the text field to the File’s Owner and selecting delegate in the transparent panel that appears.

>> You can now test the application by building and running it. (Note: There will be several compiler
warnings because you haven’t yet implemented accessor methods for the properties—you’ll fix these
in the next chapter.) You should find that the button works (it highlights when you tap it). You should
also find that if you touch in the text field, the keyboard appears and you enter text. There is, though,
still no way to dismiss the keyboard. To do that, you have to implement the relevant delegate method.
You’ll do that in the next chapter.
Important: In beta 5, if you run your application using Simulator, when you tap inside the text field
your application will crash. This is a known issue and will be fixed in a future release. As a workaround,
you can create the text field programmatically.

Recap
You added instance variables and property declarations, and a declaration for the action method, to
the view controller class interface. You added a stub implementation of the action method to the class
implementation. You also configured the nib file.

Recap
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There are several parts to implementing the view controller. You need to deal with the instance
variables—including memory management—implement the changeGreeting: method, and ensure
that the keyboard is dismissed when the user taps Return.

The Properties
You first need to tell the compiler to synthesize the accessor methods.
>> In the MyViewController.m file, add the following after the @implementation MyViewController
line:
@synthesize textField;
@synthesize label;
@synthesize string;

This tells the compiler to synthesize accessor methods for these properties according to the specification
you gave in the interface file. For example, the declaration of the string property is @property
(nonatomic, copy) NSString *string;), so the compiler generates two accessor methods:
- (NSString *)string and - (void)setString:(NSString *)newString. In the setString:
method a copy is made of the string that’s passed in. This is useful to ensure encapsulation (the
passed-in string might be mutable—you want to make sure that the controller maintains its own
copy). For more about encapsulation, see "Mechanisms Of Abstraction" in Object-Oriented Programming
with Objective-C.
You must relinquish ownership in the dealloc method because all of the property declarations specify
that the view controller owns the instance variables (copy implies ownership, see Memory Management
Rules in Memory Management Programming Guide for Cocoa).
>> In the MyViewController.m file, update the dealloc method to release the properties before
invoking super’s implementation:
- (void)dealloc {
[textField release];
[label release];
[string release];
[super dealloc];
}

The Properties
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The changeGreeting: Method
When it’s tapped, the button sends a changeGreeting: message to the view controller. The view
controller then should retrieve the string from the text field and update the label appropriately.
>> In the MyViewController.m file, complete the implementation of the changeGreeting: method
as follows:
- (IBAction)changeGreeting:(id)sender {
self.string = textField.text;
NSString *nameString = string;
if ([nameString length] == 0) {
nameString = @"World";
}
NSString *greeting = [[NSString alloc] initWithFormat:@"Hello, %@!",
nameString];
label.text = greeting;
[greeting release];
}

There are several pieces to this method.
■

self.string = textField.text;

This retrieves the text from the text field and sets the controller’s string instance variable to the
result.
In this case, you don’t actually use the string instance variable anywhere else, but it’s important
to understand its role. It’s the very simple model object that the view controller is managing. In
general, the controller should maintain information about application data in its own model
objects—application data shouldn’t be stored in user interface elements.
■

@"World" is a string constant represented by an instance of NSString.

■

The initWithFormat: method creates a new string that follows the format specified by the format
string, like the printf function. %@ indicates that a string object should be substituted. To learn
more about strings, see String Programming Guide for Cocoa.

The Text Field’s Delegate
If you build and run the application, you should find that if you tap the button, the label shows “Hello,
World!”. If you select the text field and start typing, though, you should find that you have no way
to indicate that you’ve finished entering text. To remedy this you need to implement the text field’s
delegate method so that tapping Return completes text entry.
>> In the MyViewController.m file, implement the textFieldShouldReturn: method as follows:
- (BOOL)textFieldShouldReturn:(UITextField *)theTextField {
if (theTextField == textField) {
[textField resignFirstResponder];
}
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return YES;
}

In this application, it’s not really necessary to include the theTextField == textField test since
there’s only one text field. It’s worth pointing out the pattern, though, since there may be occasions
when your object is the delegate of more than one object of the same type and you may need to
differentiate between them.
>> Build and run the application; it should behave as you expect. (Tap Return to dismiss the keyboard
when you have entered your name, then tap the Hello button to display “Hello, <Your Name>!” in
the label.)
If the application doesn’t behave as you expect, you need to troubleshoot.

Troubleshooting
If things aren’t working as they should, first compare your code with the complete listing in “Complete
Code Listings for MyViewController” (page 43) (or with the code in the HelloWorldClassic sample
application). In addition to the code, though, check your nib files.
As a developer, if things don’t work correctly, your natural instinct is to check your source for bugs.
Cocoa adds another dimension. Much of your application’s configuration may be “encoded” in the
nib files. And if you haven’t made the correct connections, then your application won’t behave as
you expect. In this application, if the text doesn’t update when you tap the button, it might be that
you didn’t connect the button’s action to the view controller, or connect the view controller’s outlets
to the text field or label. If the keyboard does not disappear when you tap Return, you may not have
connected the text field’s delegate. If you have connected the delegate, there may be a more subtle
problem.
A common mistake with delegates is to misspell the delegate method name. Even if you’ve set the
delegate object correctly, if the delegate doesn’t implement the method with exactly the right name,
it won’t be invoked. It’s usually best to copy and paste delegate method declarations from the
documentation.
Finally, pay close attention to any compiler warnings. Objective-C is a very flexible language, and so
sometimes the most you get from the compiler is a warning. Typically you should treat warnings as
very likely to be errors.

Complete Code Listings for MyViewController
The code listings don’t show comments and other method implementations from the file template.
The header file:
#import <UIKit/UIKit.h>
@interface MyViewController : UIViewController <UITextFieldDelegate> {
IBOutlet UITextField *textField;
IBOutlet UILabel *label;
NSString *string;

Troubleshooting
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}
@property (nonatomic, retain) UITextField *textField;
@property (nonatomic, retain) UILabel *label;
@property (nonatomic, copy) NSString *string;
- (IBAction)changeGreeting:(id)sender;
@end

The implementation file:
#import "MyViewController.h"
@implementation MyViewController
@synthesize textField;
@synthesize label;
@synthesize string;
- (IBAction)changeGreeting:(id)sender {
self.string = textField.text;
NSString *nameString = string;
if ([nameString length] == 0) {
nameString = @"World";
}
NSString *greeting = [[NSString alloc] initWithFormat:@"Hello, %@!",
nameString];
label.text = greeting;
[greeting release];
}
- (BOOL)textFieldShouldReturn:(UITextField *)theTextField {
if (theTextField == textField) {
[textField resignFirstResponder];
}
return YES;
}
- (void)dealloc {
[textField release];
[label release];
[string release];
[super dealloc];
}
// Other methods from the template omitted
@end

Recap
You finished the implementation of the view controller and so completed your first iPhone application.
Congratulations.
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Take a moment to think about how the view controller fits into the overall application architecture.
You’re likely to use view controllers in most iPhone applications you write.
Then take a break, and start to think about what you should do next.
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This chapter offers suggestions as to what directions you should take next in learning about iPhone
development.

The User Interface
In this tutorial, you created a very simple iPhone application. Cocoa Touch offers a rich development
environment, though, and you’ve only scratched the surface. From here, you should explore further.
Start with this application. As noted in the first chapter, the user interface is critical to a successful
iPhone application. Try to improve the user interface. Add images and color to the elements. Add a
background image and an icon for the application. Look at the inspectors in Interface Builder to see
how else you can configure elements.

Creating User Interface Elements Programmatically
In the tutorial, you created the user interface using Interface Builder. Interface Builder allows you to
assemble user interface components quickly and easily. Sometimes, however, you may want—or
need—to create user interface elements in code (for example, if you create a custom table view cell
you typically create and lay out the subviews programmatically).
First, open the ControllerView nib file and remove the text field from view.
If you want to create the entire view hierarchy for a view controller in code, you override loadView.
In this case, however, you want to load the nib file then perform additional configuration (add another
view). You therefore override viewDidLoad instead. (The viewDidLoad method gives you a common
override point you can use whether you load the main view using a nib file or by overriding loadView.)
In MyViewController.m, add the following implementation of viewDidLoad:
- (void)viewDidLoad {
CGRect frame = CGRectMake(20.0, 68.0, 280.0, 31.0);
UITextField *aTextField = [[UITextField alloc] initWithFrame:frame];
self.textField = aTextField;
[aTextField release];

The User Interface
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textField.textAlignment = UITextAlignmentCenter;
textField.borderStyle = UITextBorderStyleRoundedRect;
textField.autocapitalizationType = UITextAutocapitalizationTypeWords;
textField.keyboardType = UIKeyboardTypeNamePhonePad;
textField.returnKeyType = UIReturnKeyDone;
textField.delegate = self;
[self.view addSubview:textField];
}

Notice that there’s quite a lot of code compared with how easy it was to create and configure the text
field in Interface Builder.
Build and run the application. Make sure it behaves as it did before.

Additional Functionality
Next you can try expanding on the functionality. There are many directions in which you can go:
■

Rather than using a view as a canvas on which to drop prebuilt user interface controls, you might
try writing a custom view that draws its own content or responds to touch events. For inspiration,
look at examples such as MoveMe, Metronome, and Kalimba.

■

Although you used Interface Builder to layout the user interface for this application, many
applications actually use table views to lay out the interface. This makes it easy to create an
interface that extends beyond the bounds of the screen—allowing the user to easily scroll to reveal
additional elements. You should first investigate how to create a simple list using a table view.
There are several sample code projects that you can look at—including TableViewSuite—then
you can start with the Cocoa Touch Xcode List template and create your own.

■

Navigation controllers and tab bar controllers provide an architecture that allow you to create
drill-down style interfaces and let the user select different views in your application. Navigation
controllers often work in conjunction with table views, but both navigation controllers and tab
bar controllers work together with view controllers. Have a look at some of the sample
applications—such as SimpleDrillDown—that use navigation controllers and expand on them
to create your own applications.

■

You can often increase the size of your potential marketplace by localizing your application.
Internationalization is the process of making your application localizable. To learn more about
internationalization, read Getting Started with Internationalization.

■

Performance is critical to good user experience on iPhone. You should learn to use the various
performance tools provided with Mac OS X—in particular Instruments—to tune your application
so that it minimizes its resource requirements.

The most important thing is to try out new ideas and to experiment—there are many code samples
you can look at for inspiration, and the documentation will help you to understand concepts and
programming interface.
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